Game Statistics and Information System (GSIS)
Data Entry
User’s Guide

NFL GSIS Support: (877) 635-0171
Non Gameday Support: (212) 450-2442
# Contents

**About this Guide vii**
- What You Should Know viii
- Introduction viii
- Audience viii
- Typographical Conventions viii
- Keystrokes viii
- Input viii
- Chapter and Section References viii
- Menus, Menu Commands, and Command Buttons viii
- Notes viii
- Contents ix
- Terms Used in this Guide ix
- Related Documentation ix

**GSIS Overview** 1

- The GSIS Software 2
- Introduction 2
- The GSIS Interface 2
- Set Up 2
- In Game 2
- Real-Time Statistics Exporter 2
- GSIS Training Mode 2
- View Historical Games 2
- TV Stats 2
- User Roles 3
- Introduction 3
- What Are User Roles? 3
- Primary Data Entry 3
- Audit 3
- PR Home 3
- PR Visitor 3
- Distribution Center 3
- Pre-game Setup 4
- Introduction 4
- Roster Updates 4
- Player Starter Updates 4
- Player Default Updates 4
- How Does Player Defaults Work? 4
- Game Play 5
Contents

Events and Attributes Window 23
Play Board 24
Play Stats 25
Team Stats 26
Score Window 26
Data Entry Field 26
Play List/Description Window 27
Drive Chart Screen (Shift+F6) 29
Offensive Stats Screen (Shift+F7) 30
Defensive Stats Screen (Shift+F8) 31
Team Stats Screen (Shift+F9) 32
Notes Screen (Shift+F11) 32

Pre-game Setup 31

Editing the Rosters 32
Introduction 32
Displaying the Rosters/Starters Screen (Shift+F1) 32
Updating Player Information (Alt+I) 33
Correcting Invalid Rosters 33
Acquiring a Player (Alt+A) 36
Adding a New Player (Alt+N) 38
Changing a Player’s Status 40
Official Player Positions 40
Deleting a Player from the Roster (Alt+D) 42
Depth Charts 42
Coaches 43
Editing Player Defaults 44
Introduction 44
Displaying the Player Defaults Screen (Shift+F2) 44
Assigning a Player Default 45

Game Play 47

Entering Plays 48
Introduction 48
Play Entry Function Keys 48
Play Entry Keyboard Shortcuts 49
Auto Complete 49
Yard Line Entry 50
Player Entry 50
Starting the Game (Game Event) 50
Entering Pre-game Information 50
Entering an Event 52
Entering an Attribute Value 52
Contents

Basic Play Entry 53
Setting the Play Start Time (F11) 58
Setting the Start Time of Day (Ctrl+F11) 58
Setting the Play End Time (F12) 58
Inserting a Play Before the Selected Play (Ctrl+F2) 59
Ending the Current Play (Ctrl+E) 59
Ending the Current Play and Creating a New Play (Ctrl+Enter) 59
Creating a New Play (Ctrl+N) 59
Change of Possession 59
Crossing Midfield 59
Finding a Play (Ctrl+F) 60
Correcting a Play 62
Flagging a Play (Ctrl+G) 63
Moving Between Open Plays and Flagged Plays (Ctrl+F7 and Ctrl+F8) 63
Deleting a Play (Ctrl+F3) 63
Inserting an Event Before the Selected Event (F2) 64
Deleting an Event (F3) 64
Moving an Event (Ctrl-M) 65
Using the Choices Window (F4) 66
Displaying the Choices Window 66
Selecting an Entry from the Choices Window 67
Using the Find Field 67
Printing the Choices Window 67
Entering a Play Comment 67
Editing Play Statistics (F6) 68
Displaying the Play Statistics Dialog 68
Updating Play Statistics 69
Adding Statistics to a Play 70
Removing Statistics from a Play 70
Removing All Override Statistics from a Play 70
Displaying the Play List 71
Displaying a Play Description 72
Refreshing the Game Play Screen (Ctrl-F5) 72
Auto-Scroll Mode (F9) 72
Ending the Game (End of Game Event) 72
Displaying Game Statistics 73
Introduction 73
Displaying the Drive Chart (Shift+F6) 73
Displaying Offensive Statistics (Shift+F7) 74
Displaying Defensive Statistics (Shift+F8) 75
Displaying Team Statistics (Shift+F9) 76
Displaying Notes 77
Introduction 77
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying Notes &lt;Shift+F11&gt;</td>
<td>77</td>
</tr>
<tr>
<td>Printing Reports and Lists</td>
<td>78</td>
</tr>
<tr>
<td>Introduction</td>
<td>78</td>
</tr>
<tr>
<td>Printing a Report</td>
<td>78</td>
</tr>
<tr>
<td>Printing a Report to a File</td>
<td>79</td>
</tr>
<tr>
<td>Changing the Printer</td>
<td>79</td>
</tr>
<tr>
<td>Printing the Play-by-play Report for Selected Quarters</td>
<td>80</td>
</tr>
<tr>
<td>Previewing a Report</td>
<td>82</td>
</tr>
<tr>
<td>Printing a Text File Report</td>
<td>83</td>
</tr>
<tr>
<td>Printing Lists</td>
<td>84</td>
</tr>
<tr>
<td>Changing Application Options</td>
<td>85</td>
</tr>
<tr>
<td>Changing GamePlay Options</td>
<td>85</td>
</tr>
<tr>
<td>Changing Report Options</td>
<td>86</td>
</tr>
<tr>
<td>Changing Sound Options</td>
<td>87</td>
</tr>
<tr>
<td><strong>Post-game Activities</strong></td>
<td>87</td>
</tr>
<tr>
<td>Updating Player Status</td>
<td>88</td>
</tr>
<tr>
<td>Introduction</td>
<td>88</td>
</tr>
<tr>
<td>Updating the Status of a Player</td>
<td>88</td>
</tr>
<tr>
<td>Printing the Game Book</td>
<td>89</td>
</tr>
<tr>
<td>Introduction</td>
<td>89</td>
</tr>
<tr>
<td>Printing the Game Book</td>
<td>89</td>
</tr>
<tr>
<td>Closing the Game</td>
<td>90</td>
</tr>
<tr>
<td>Introduction</td>
<td>90</td>
</tr>
<tr>
<td>Closing the Game</td>
<td>90</td>
</tr>
<tr>
<td><strong>Running GSIS in Training Mode</strong></td>
<td>1</td>
</tr>
<tr>
<td>GSIS Training Mode</td>
<td>2</td>
</tr>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Running the Training Program without an ISDN Connection</td>
<td>2</td>
</tr>
<tr>
<td><strong>Viewing Historical Games</strong></td>
<td>1</td>
</tr>
<tr>
<td>View Historical Games</td>
<td>2</td>
</tr>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Viewing Historical Games</td>
<td>2</td>
</tr>
</tbody>
</table>
About this Guide

This section explains the typographical conventions used in this guide, and provides a description of each chapter and appendix.

What You Should Know

<table>
<thead>
<tr>
<th>Introduction</th>
<th>This guide describes GSIS and the tools and techniques that you need to capture a football game quickly and accurately.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience</td>
<td>This guide is intended for use by data entry personnel.</td>
</tr>
<tr>
<td>Typographical Conventions</td>
<td>This guide uses the following typographical conventions.</td>
</tr>
</tbody>
</table>

**Keystrokes**

Keys that you press are set in **bold** type and enclosed in angle (<> brackets. For example:

Press `<Enter>`.

**Input**

Information that you type is set in **bold** type. For example:

Enter v45 in the **Data Entry** field.

**Chapter and Section References**

Chapter and section names are set in *italic* type. For example:

Please refer to *Acquiring a Player*, in Chapter 4, *Game Play*.

**Menus, Menu Commands, and Command Buttons**

Menus, menu commands, and command buttons are set in **bold** type. For example:

- Select **Offensive Stats** from the **Go** menu.
- Click **Next**.

**Notes**

Information that further clarifies a procedure or a concept is preceded by
About this Guide

What You Should Know

the ‡ symbol, and set in italic type. For example:

‡ Press <Alt+I> if this tab is not currently being displayed.

Contents

This guide contains the following chapters and appendices:

**Chapter 1: GSIS Overview**
Chapter 1 describes the GSIS interface, GSIS functionality, and the concept of user roles.

**Chapter 2: Using the Software**
This chapter provides a list of keyboard shortcuts, and descriptions and examples of GSIS screens.

**Chapter 3: Pre-game Setup**
Chapter 3 contains procedures that you must perform prior to the start of a game.

**Chapter 4: Game Play**
This chapter provides procedures for entering game play information and displaying statistics.

**Chapter 5: Post-game Activities**
Chapter 5 contains procedures that you must perform after the game has ended.

**Appendix A**
This appendix describes the use of GSIS training mode.

**Appendix B**
Appendix B describes the use of the View Historical Games program.

**Terms Used in this Guide**

**Distribution Center (DC)**
The DC maintains a database of all game statistics. All statistics generated during a game are sent to the DC in real time.

**Focus**
The term *focus* applies to the active field or window element. For example, if the *Data Entry* field is currently active, it is said to have the *focus*.

**Related Documentation**
This guide should be used in conjunction with the *Events and Attributes Guide*. 
# Chapter 1

## GSIS Overview

This chapter provides an overview of GSIS, including its interface and functionality.

### The GSIS Software

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>Welcome to the Game Statistics and Information System (GSIS). This system has been specifically designed for the National Football League (NFL) to capture play-by-play game data at each NFL stadium. In addition, GSIS generates timely documentation such as the game book and statistical reports. These documents are distributed to the media and used by NFL clubs, the League Office, and published on NFL.com.</td>
</tr>
<tr>
<td><strong>The GSIS Interface</strong></td>
<td>The GSIS interface consists of two main parts: Setup and Game Play.</td>
</tr>
<tr>
<td><strong>Set Up</strong></td>
<td>The Set Up portion is used to perform tasks that are required prior to the start of a game. This is referred to as pre-game setup in this guide.</td>
</tr>
<tr>
<td><strong>In Game</strong></td>
<td>The In Game portion is used to enter game play information and view game statistics. This is referred to as game play in this guide.</td>
</tr>
<tr>
<td><strong>Real-Time Statistics Exporter</strong></td>
<td>The Real-Time Statistics Exporter is used in those stadiums that have established interfaces with their stadium scoreboard display systems. The Real-Time Statistics Exporter program sends real-time game statistics to the scoreboard computer, which displays the statistics on the scoreboard.</td>
</tr>
<tr>
<td><strong>GSIS Training Mode</strong></td>
<td>GSIS training mode is used to enter play-by-play for the purposes of training users. See Appendix A, Running GSIS in Training Mode, for more information.</td>
</tr>
<tr>
<td><strong>View Historical Games</strong></td>
<td>The View Historical Games program is used to view data that has been entered for games that have already been played. See Appendix B, Viewing Historical Games, for more information.</td>
</tr>
<tr>
<td><strong>TV Stats</strong></td>
<td>TV Stats are used to display the game statistics on the TV monitors in the press box.</td>
</tr>
</tbody>
</table>
User Roles

Introduction

This section introduces the concept of user roles, and explains the tasks that each role can perform during a game.

What Are User Roles?

All of the laptops can perform any of the following roles: Primary Data Entry, Audit, PR Home, PR Visit, and Distribution Center. The role played by each laptop is determined when that laptop is logged into Windows. The user roles are defined below.

Primary Data Entry

The Primary Data Entry (PDE) role allows the operator to enter play information during a game.

Audit

The Audit role allows the operator to verify and correct game play information entered by the PDE operator. The auditor can edit data only when the PDE laptop is communicating with the Audit laptop.

PR Home

The PR Home role allows the operator to view game statistics. This role does not allow the operator to modify any of the data in the system; however, he or she can enter notes about each play of the game.

In stadiums where the Real-Time Statistics Exporter is used, this laptop provides the backup feed to the scoreboard computer.

PR Visitor

The PR Visitor role allows the operator to view game statistics. This role does not allow the operator to modify any of the data in the system.

In stadiums where the Real-Time Statistics Exporter is used, this laptop provides the primary feed to the scoreboard computer.

Distribution Center

The Distribution Center role is used by the support staff at the Help Desk monitoring each game. This role has the rights of the PDE and PR Visitor roles. This role also allows you to access the tools in GSIS used to monitor the flow of data from the stadium to the external business partners.

Pre-game Setup

Introduction

Pre-game setup includes activities that you must perform prior to the beginning of the game. You access these tasks from the Set Up component. These tasks are described in the following sections.

Roster Updates

The current team rosters are received on a flip card from the NFL prior to the start of a game.

You must make sure that you have valid rosters prior to the start of a game.
game. Your rosters should match the rosters on the flip card.

### Player Starter Updates

The starting players are those players who appear on the flip card. We recommend that you enter the predicted starting lineups for both clubs prior to the start of a game when you are entering the roster data from the flip cards.

At some point before the end of the first quarter, the Auditor should print out two copies of the Game Summary report, and distribute them to the home and visiting public relations staffs. The public relations staff for each club will verify that the starters entered into GSIS were the actual starters in the game.

### Player Default Updates

When you enter a play in GSIS, each player participating in the play must be identified to maintain accurate statistics.

**How Does Player Defaults Work?**

For example, at 4th down and 15, Team A decides to punt the ball. The ball is punted and a player on Team B receives the punt. Both of these players must be entered into the system. Instead of having to enter both players, Player Defaults allows you to identify to GSIS the names of the players who are initially playing those positions.

As you enter the play, GSIS automatically enters the name of the punter for Team A and the name of the punt receiver for Team B. Subsequently, each time Team A punts the ball and each time Team B receives a punt, these players will be used.

The players associated with these positions will be used as default players until a different player for that position enters the game. For subsequent plays involving these two positions, the new players will be considered the default and will continued to be used. Only updates made to the last play in the system affect what player GSIS uses as the default player for that attribute.

### Game Play

**Introduction**

The Game Play component allows you to do the following:

- Enter play information
- Display statistics
- Enter comments about the game

**Play Entry**

Play-by-play data entry is based on the Events and Attributes Model. This model is described below. For detailed information about game events and attributes, please refer to the *GSIS Events and Attributes Guide*.

**Events and Attributes Model**

GSIS records a game of football as a sequence of plays. Each play consists of a sequence of events. Each event consists of a series of attributes.

**How Does the Events and**

The large majority of rushing plays can be described as a sequence of three events: snap, handoff, and tackle. The play will always start with a
Attributes Model Work?

The quarterback will usually hand off the ball. The runner will usually be tackled. If the quarterback were to rush, we could just omit the handoff event. If the runner were to avoid being tackled while staying in bounds, we could replace the tackle with a different event: touchdown!

What else is there to know about the play? We need to know: Who snapped the ball? Who handed off the ball? Who made the tackle, and where was the tackle made?

Information about events are what we shall call attributes. For example, our snap event might have one attribute that indicates who snapped the ball, and another that indicates who received the ball. For our tackle event, we want attributes that tell us who made the tackle and where the tackle was made.

Another thing that we want to know about the play is where it began. What down was it? How many yards was the team from a first down? To record this information, we’ll simply define another event and give it the necessary attributes. In GSIS, we would enter this event as the first event of the play.

Rushing Play in Football Terms

In ordinary football terms, a simple rushing play might be described as follows:

1. Team A has the ball first-and-10 at its own 20-yard line.
2. The center snaps the ball to the quarterback.
3. The quarterback hands off the ball to the halfback.
4. The linebacker tackles the halfback at the 25-yard line.

Events and Attributes of the Rushing Play

In terms of events and attributes, the same play could be recorded as follows:

<table>
<thead>
<tr>
<th>Play from Scrimmage</th>
<th>Possession: Team A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Down: 1</td>
</tr>
<tr>
<td></td>
<td>Yards to Go: 10</td>
</tr>
<tr>
<td></td>
<td>Yard Line: A20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Snap</th>
<th>Snapped by: Center</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Snapped to: Quarterback</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Handoff</th>
<th>Handoff to: Halfback</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Tackle</th>
<th>Tackled by: Linebacker</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Yard line: A25</td>
</tr>
</tbody>
</table>
**GSIS Example of the Rushing Play**

We do not need to enter who snapped the ball and who received the ball because these events are of no statistical interest. Instead, GSIS replaces the snap and handoff events with just one event, the Rush. In this manner, the rush play we have discussed would actually be recorded as follows:

- **Play from Scrimmage**: Possession: Team A  
  Down: 1  
  Yards to Go: 10  
  Yard Line: A20

- **Rush**: Runner: Halfback  
  Direction: Up the Middle

- **Tackle**: Tackled by: Linebacker  
  Yard Line: A25

**Next Events**

A key concept behind the Events and Attributes model is that of next events. Football events occur in a chronological sequence. After we have defined them as football events, there is the implication that these events will follow recognizable patterns. The possible patterns are determined by the official rules of football.

For example, the touchdown event cannot follow the fair catch event because when a fair catch occurs, the play ends. In this manner, for each of our events, we are able to define a set of all possible next events.

**Post-game Activities**

**Introduction**

You perform post-game activities after the last play of the game, but before you close the game.

**Roster Updates**

After the end of the game, you need to update the status of individual players in the team rosters (for example, if a player did not play, his status must be changed to indicate this).

**Print the Gamebooks and Verify**

At the conclusion of the game, the statistics crew must verify that the information that was entered into GSIS is accurate. Once the head statistician approves, the gamebook should be printed and distributed to the home club’s public relations staff. The following seven reports make up the gamebook:

- Game Summary
- Final Individual Statistics
- Final Team Statistics
- Ball Possession and Drive Chart
- Defensive Statistics
- First Half Summary
• Play-by-play

Some clubs may want additional reports included as part of the gamebook. The home club's public relations director will tell the head statistician what additional reports, if any, should be included and where the reports should be placed in the gamebook.

Close Game

After all statistics have been verified and you have printed the game book for distribution, you must close the game.
Chapter 2

Using the Software

This chapter describes GSIS design and provides samples and descriptions of GSIS screens.

GSIS Design

Introduction
Although GSIS runs on a Microsoft Windows platform, every effort has been made to minimize your reliance on a mouse to navigate the screens and perform actions. This has been accomplished through the extensive use of keyboard shortcuts and function keys. We recommend that you master these techniques.

Keyboard Shortcuts for Windows Elements

There are a number of keyboard shortcuts that you can learn to minimize your use of a mouse when working with Windows elements.

Field Navigation
The <Tab> key and the <Shift+Tab> key combination are used to move the cursor from field to field on any screen.

Combo boxes
A combo box contains a list of valid entries.

To display the list, use the <Tab> key to access the desired combo box, and press <Alt+↓>.

To select an entry from a list box, use the <↑> and <↓> keys to highlight the desired item, and press <Enter>.

You can also select an entry from the list box by typing the first letter of the entry that you want to select. For example, pressing <G> will bring you to the first entry in the list that starts with the letter G.

Check Boxes
Check boxes represent a true or false condition. To set the value of a check box, use the <Tab> key to select the appropriate check box on the screen, and press <Spacebar> to toggle the value of the check box.

Radio Buttons
Radio buttons represent a group of choices. Only one selection within a group of radio buttons can be selected at one time. To make a choice
within a group of radio buttons, use the <Tab> key to select the radio button group, and use the <↑> and <↓> keys to select the desired radio button.

**List View Controls**

A list view control is a special extended selection list box that displays a collection of items. Each item appears as a line in a multicolumn format. Arrow keys can be used to navigate through items in the list view. List view also supports time-out based matching for text keys. This allows you to type in the first characters of an item in a list view, and the control will incrementally navigate to that item in the list. A small delay in typing will reset the value that is typed in.

**Exiting a Dialog**

Press <Esc> to close an open dialog.

**Menu Commands**

The menu bar appears on the screen just below the title bar. The menu bar contains menus that list available commands.

To access a menu, press <Alt> to activate the Menu bar, then press underlined letter of the desired menu. For example, if you want to access the File menu, press <F>. Do not use the <Alt+F> key combination, as this may interfere with function-specific keyboard shortcuts.

To select a menu command, use the <↑> and <↓> keys to highlight the desired command, and press <Enter>.

You can also select a menu command from the menu by typing the underlined letter of the command that you want to select. For example, if you have accessed the File menu, and you want to select the Print Reports... command, press <P> to display the Print Reports dialog. You do not need to press <Alt> again.

**Keyboard Shortcuts for GSIS Screen Navigation**

The following table lists each screen and the key combination used to access it.

<table>
<thead>
<tr>
<th>GSIS Screen</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rosters/Starters</td>
<td>&lt;Shift+F1&gt;</td>
</tr>
<tr>
<td>Player Defaults</td>
<td>&lt;Shift+F2&gt;</td>
</tr>
<tr>
<td>TV Stats</td>
<td>&lt;Shift+F3&gt;</td>
</tr>
<tr>
<td>Startup</td>
<td>&lt;Shift+F4&gt;</td>
</tr>
</tbody>
</table>
Chapter 2: Using the Software  GSIS Set Up Screens (Ctrl+U)

<table>
<thead>
<tr>
<th>Game Play</th>
<th>&lt;Shift+F5&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Chart</td>
<td>&lt;Shift+F6&gt;</td>
</tr>
<tr>
<td>Offensive Stats</td>
<td>&lt;Shift+F7&gt;</td>
</tr>
<tr>
<td>Defensive Stats</td>
<td>&lt;Shift+F8&gt;</td>
</tr>
<tr>
<td>Team Stats</td>
<td>&lt;Shift+F9&gt;</td>
</tr>
<tr>
<td>Notes</td>
<td>&lt;Shift+F11&gt;</td>
</tr>
</tbody>
</table>

GSIS Set Up Screens (Ctrl+U)

Introduction

This section provides descriptions and samples of the GSIS Set Up screens.

Rosters/Starters Screen (Shift+F1)

You access the Rosters/Starters screen by pressing <Shift+F1>.

The Rosters/Starters screen is used to edit a current player, create a new player, acquire an existing player from another roster, and delete a player from a roster. It also provides an area to enter the starting players and positions for each team.

![Figure 1: Rosters/Starters Screen](image)

The Rosters/Starters screen consists of the following areas:

- Roster list (Home and Visitor)
- Player Info tab
• Player Starters tab

Roster List

The roster list contains two tabs, one for the home team and one for the visiting team. Team displays can be toggled by clicking on the tabs, or pressing <Alt+H> and <Alt+V>. Each list consists of the players that are currently on that team’s roster. Clicking on the column headers will sort the list by the column selected. Rosters for both teams are automatically generated by the system based on the rosters for the teams’ last game. Rosters need to be checked prior to the game, and in most cases will need some minor modifications.
Chapter 2: Using the Software

<table>
<thead>
<tr>
<th>Tampa Bay Buccaneers (H)</th>
<th>New York Giants (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Player Name</td>
</tr>
<tr>
<td>---</td>
<td>-------------</td>
</tr>
<tr>
<td>21</td>
<td>Abraham, Donnie</td>
</tr>
<tr>
<td>72</td>
<td>Ahanotu, Chidi</td>
</tr>
<tr>
<td>40</td>
<td>Alstott, Mike</td>
</tr>
<tr>
<td>85</td>
<td>Anthony, Reidel</td>
</tr>
<tr>
<td>20</td>
<td>barber, Ronde</td>
</tr>
<tr>
<td>55</td>
<td>Brooks, Derrick</td>
</tr>
<tr>
<td>98</td>
<td>Cannida, James</td>
</tr>
<tr>
<td>77</td>
<td>Culpepper, Brad</td>
</tr>
<tr>
<td>76</td>
<td>Curry, DeMarcus</td>
</tr>
<tr>
<td>59</td>
<td>Davis, Don</td>
</tr>
<tr>
<td>80</td>
<td>Davis, John</td>
</tr>
<tr>
<td>64</td>
<td>Diaz, Jorge</td>
</tr>
<tr>
<td>12</td>
<td>Diller, Trent</td>
</tr>
<tr>
<td>65</td>
<td>Dogins, Kevin</td>
</tr>
<tr>
<td>59</td>
<td>Duncan, Janie</td>
</tr>
<tr>
<td>28</td>
<td>Dunn, Warrick</td>
</tr>
<tr>
<td>87</td>
<td>Emanuel, Bert</td>
</tr>
<tr>
<td>50</td>
<td>Gooch, Jeff</td>
</tr>
<tr>
<td>7</td>
<td>Gramatica, Martin</td>
</tr>
<tr>
<td>81</td>
<td>Green, Jacquez</td>
</tr>
<tr>
<td>82</td>
<td>Hage, Patrick</td>
</tr>
<tr>
<td>79</td>
<td>Hegamin, George</td>
</tr>
<tr>
<td>34</td>
<td>Jackson, Dexter</td>
</tr>
<tr>
<td>97</td>
<td>Jackson, Tyoka</td>
</tr>
<tr>
<td>78</td>
<td>Jones, Marcus</td>
</tr>
<tr>
<td>91</td>
<td>Jordan, Antony</td>
</tr>
<tr>
<td>25</td>
<td>Kelly, Brian</td>
</tr>
<tr>
<td>10</td>
<td>King, Shaun</td>
</tr>
<tr>
<td>47</td>
<td>Lynch, John</td>
</tr>
<tr>
<td>61</td>
<td>Mayberry, Tony</td>
</tr>
<tr>
<td>48</td>
<td>McAfee, Fred</td>
</tr>
<tr>
<td>84</td>
<td>McDonald, Darnell</td>
</tr>
<tr>
<td>92</td>
<td>McFarland, Anthony</td>
</tr>
<tr>
<td>95</td>
<td>McLaughlin, John</td>
</tr>
<tr>
<td>43</td>
<td>McLeod, Kevin</td>
</tr>
<tr>
<td>73</td>
<td>Middleton, Frank</td>
</tr>
<tr>
<td>13</td>
<td>Milanovich, Scott</td>
</tr>
<tr>
<td>83</td>
<td>Moore, Dave</td>
</tr>
<tr>
<td>56</td>
<td>Nickerson, Hardy</td>
</tr>
<tr>
<td>69</td>
<td>Pierson, Pete</td>
</tr>
<tr>
<td>53</td>
<td>Qualls, Sheldon</td>
</tr>
</tbody>
</table>

Total Players on Roster: 53

Figure 2: Roster List

The information for each player includes:
- **##** – the uniform number of the player
- **Player Name** – the player’s last and first names
- **Pos** – the player’s position
- **Status** – Played, Did not Play, and so on

- If the focus is on the roster list, typing in a player’s uniform number will position the highlight bar on that player.
**Player Info Tab**

The **Player Info** tab contains detailed information about the player selected in the roster list.

![Figure 3: Player Info Tab](image)

The **Player Info** area is used to update the information on the roster. You can correct individual player information (for example, uniform number), or you can add players to, or delete players from, the roster. The player information comes from the flip card.

The **Roster Status** area is used to notify you of any invalid conditions that exist in the roster. The left list contains error messages about duplicate jersey numbers and players with invalid jersey numbers. The list on the right contains error messages about players without official positions.

A valid roster is necessary for proceeding to other areas of GSIS. For
example, duplicate uniform numbers could exist if an acquired player has a number that has already been used by another player on the roster. This situation will create an invalid roster. Missing official positions will not limit access to the play entry screen, but the game cannot be closed until all players have an official position.

Player Starters Tab

The Player Starters tab is divided into two areas: the Offensive Starting Lineup and the Defensive Starting Lineup.

To update a team’s starters, click a cell in the jersey number column. Enter the player’s jersey number, and press enter or the arrow keys. GSIS will automatically set the player’s name. You may need to change the player’s position, if his depth chart position does not match his position on the back of the flip card.

Starters will be automatically generated on game day based upon the starters from the previous week. GSIS data entry operators are required to make any changes necessary for the current week.
Player Defaults Screen (Shift+F2)

You access the Player Defaults screen by pressing <Shift+F2>.

The information on the Player Defaults screen is downloaded from the Distribution Center along with the rosters and starters. This information is based on what was entered during the last game played by the team. Changes to player defaults should be made prior to the start of the game.

The Player Defaults screen displays the home and visitor defaults side-by-side. To facilitate the entry of plays, you may assign a player from each team to a position that will be used as a default for specific events and attributes.

TV Stats Screen (Shift+F3)

This screen is not used by data entry personnel.

The TV Stats screen is used by PR personnel to display the game statistics on the TV monitors in the press box.

Startup Screen (Shift+F4)

The Startup screen appears when GSIS is first run.

You can access this screen anytime during a game by pressing <Shift+F4>.
Figure 6: Startup Screen

The Startup screen contains the following parts:

**Menu Bar**
The Menu bar includes menus and commands.

**Section Title**
The section title displays the title of the application area that you have entered.

**Navigation Bar**
The navigation bar contains icons that you can use to access specific areas of GSIS. The user can click on an icon, or use the keyboard shortcut to enter each section. The navigation bar contains two parts: **Set Up** and **In Game**. **Set Up** contains the functions that are primarily performed before the game starts. **In Game** contains functions that generally occur while the game is in progress.

**System Status Message**
The system status message displays useful information throughout the application. This message will change depending on what functions are
executing.

**Status Bar**
The status bar displays meaningful information about the current game, as well as some context-sensitive information. The status bar consists of the following parts:

- Description of what is currently occurring in GSIS, as well as useful information while navigating
- Count of Open Plays
- Count of Flagged Plays
- GSIS Connection Status Message
- Battery Status
- The NFL week number and season type in which the game is being played
- Date of the selected game
- Game Key (unique game number)

Balloon tooltips are sometimes displayed in the status bar. These alert you to changes in the laptop’s operating environment. If the machine gets disconnected from the WAN or the network, a balloon appears describing the situation. If the A/C power gets disconnected, a balloon periodically appears reminding you that the laptop is operating on battery power. Another balloon appears when the battery power reaches "Low" and "Critical" levels.

**GSIS In Game Screens (Ctrl+I)**

**Introduction**
This section provides descriptions and samples of the GSIS In Game screens.

**Game Play Screen (Shift+F5)**
You access the Game Play screen by pressing <Shift+F5>. The Game Play screen is the main interface from which you will enter game play information. It contains the following parts:

- Events and Attributes Window
- Play Board
- Play Stats
- Team Stats
- Score Window
- Data Entry Field
- Play/List Description Window
Chapter 2: Using the Software

GSIS In Game Screens (Ctrl+I)

Figures 7: Game Play Screen

Events and Attributes Window
The Events and Attributes window describes the events and attributes of a play.
Chapter 2: Using the Software

GSIS In Game Screens (Ctrl+I)

It contains the following fields:

- **Seq** - The sequence number assigned by the system to indicate the sequence of the event in the play
- **Code** - The smart code of the event (this field is left blank for Attributes)
- **Event/Attribute** - The description of the event or attribute
- **Value Description** - The value of the associated attribute. This information can be entered in the Data Entry field or selected from the Choices window. This field can also be filled automatically as a result of a player default or a default that is calculated by the system.

### Play Board

The play board displays information about the play that is highlighted in the play list.

<table>
<thead>
<tr>
<th>Team</th>
<th>Play Code</th>
<th>Series/Play</th>
<th>Yardage</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>NYJ 2-10</td>
<td>OAK 16</td>
<td>19-6 04</td>
<td>8 Play, 73 Yds, 1:27</td>
<td></td>
</tr>
<tr>
<td>NYJ 1-Goal</td>
<td>OAK 2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The top left cell contains information about the current play. The team with possession of the football at the start of the play, the down, distance needed to go for a first down, and yard line are listed. The top right cell lists which series the current play is part of, and the play number in the drive the current play is part of. The last item in this cell is the quarter the play is in. The bottom left cell contains information about the next play. The bottom right cell lists information about the drive the play is part of, including the number of plays, length, and time.
Play Stats

The Play Stats area displays the calculated stats of the currently selected play. These stats are accurate only when the play is not open (ended). An open play has no play stats.

The play by play text description is listed below the play statistics. If a data entry error exists on the play, the error message will be shown in this window in red.

```
Figure 10: Play Stats

<table>
<thead>
<tr>
<th>Plyr</th>
<th>Yds</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>NYJ</td>
<td></td>
<td>1st Down Passing</td>
</tr>
<tr>
<td>NYJ 16</td>
<td>14</td>
<td>Passing Yards</td>
</tr>
<tr>
<td>NYJ 87</td>
<td>14</td>
<td>Pass Reception Yards</td>
</tr>
<tr>
<td>OAK 21</td>
<td></td>
<td>Assisted Tackle</td>
</tr>
<tr>
<td>OAK 26</td>
<td></td>
<td>Tackle Assist</td>
</tr>
</tbody>
</table>

(:33) V.Testaverde pass to L.Coles pushed ob at OAK 2 for 14 yards (E. Allen, D. Gibson).
```

The Play Stats area contains the following three fields:

- **Plyr** – The team and uniform number of the player. If there is no uniform number listed, the statistic is a team statistic
- **Yds** – The number of yards credited to the player, if any
- **Desc** – The description of the stat that was credited

Play statistics can be manually altered. Refer to Editing Play Statistics in Chapter 4, Game Play. When play stats are edited, the play stats icon will appear in the heading of the Desc column.

Team Stats

The Team Stats area is used to display specific team statistics throughout the game. These statistics are updated continuously during play entry.
Figure 11: Team Stats

The information in this panel is updated after every play.

This information, as well as other team statistics, can be displayed by selecting the **Team Stats** icon from the In Game portion of the navigation bar, or by pressing `<Shift+F9>`.

**Score Window**

This window displays the current score of the game. It is updated continuously during play entry. The visiting team’s score is displayed on the top, and the home team’s score is displayed on the bottom. If a quarter has not begun, the value will be blank until the first play of the new quarter has been completed.

**Data Entry Field**

The **Data Entry** field is where you enter all game play information. In this field, you enter new events and values for attributes. A green arrow to the left of this field indicates that the focus is on the **Data Entry** field. The text above the **Data Entry** field indicates which event or attribute is currently selected in the Events and Attributes window.
GSIS will autocomplete your entry. Enter enough information to make a unique selection, and the matching item in the list will be selected for you. For players, entering the uniform number is sufficient. For yard lines, you can enter:

- 3 character club code, followed by the yard line number to explicitly indicate the yard line
- The yard line number. GSIS will assume that the play is on the same side of the field as the default value in the attribute
- H, followed by the yard line number, or V, followed by the yard line number. H and V are smart codes, standing for the home club and visiting club.

**Play List/Description Window**

This window contains two tabs: *Play List* and *Play Description*.

You access the play list by pressing `<Alt+L>` or by clicking the *Play List* tab.

The play list is used to display all of the plays that have been entered for the game at any given time. It contains the following five fields:

- **☐** - indicates that a play is open (has not yet ended)
- **✓** - indicates that a play has been flagged
- **Qtr** – indicates the quarter number during which the play was
created

- **Down** - indicates the team with possession, down, distance to go for a first down, and the location of the ball
- **Description** - the English description (play-by-play) of the play

You access the play description by pressing `<Alt+D>`.

![Figure 15: Play Description Tab](image)

The **Play Description** tab is used to display the play-by-play that has been highlighted in the **Play List** tab. This is useful when the description on the **Play List** tab is too long to see all of it. The top half of the window displays the play description and the bottom half warns you of invalid plays and events.

You access the Drive Chart screen by pressing `<Shift+F6>`.

![Figure 16: Drive Chart Screen](image)
The drive chart contains ball possession and drive statistics for both teams.

**Offensive Stats Screen (Shift+F7)**

You access the Offensive Stats screen by pressing <Shift+F7>.

The Offensive Stats screen contains the individuals players’ Rushing, Passing and Receiving statistics for both teams.

**Defensive Stats Screen (Shift+F8)**

You access the Defensive Stats screen by pressing <Shift+F8>.
The Defensive Stats screen contains the defensive statistics for each player on both teams. The key at the bottom of the screen explains the column headings.

Figure 18 shows a filtered list of defensive statistics. Filters are available for use on the Team, Offensive, Defensive and Kicking Statistics screens. These filters allow you to limit the statistical displays to a specific period of the game, for example, the first quarter.

To select a filter, click on the filter drop down menu and select the desired filter.

When a filter has been applied, the title of the screen changes to reflect that filter. For example, the Defensive Stats screen will be titled “Defensive Stats: First Half” when that filter has been applied.

To remove a filter, simply select the “All” filter option. This is the default for all screens with filters.

---

### Team Stats Screen (Shift+F9)

You access the Team Stats screen by pressing <Shift+F9>. 

---

<table>
<thead>
<tr>
<th>Player</th>
<th>TFL</th>
<th>SG</th>
<th>DG</th>
<th>QB</th>
<th>Yds</th>
<th>TD</th>
<th>INT</th>
<th>FG</th>
<th>FG %</th>
<th>BL</th>
<th>PCT</th>
<th>LG</th>
<th>LSTA</th>
</tr>
</thead>
<tbody>
<tr>
<td>W. Tomp</td>
<td>2</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>C. Johnson</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>S. Hardin</td>
<td>2</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>G. Glenn</td>
<td>2</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

---

**Figure 18: Defensive Stats Screen**
Chapter 2: Using the Software

GSIS In Game Screens (Ctrl+I)

The Team Stats screen contains categorized full-team statistics for both teams.

The Notes screen contains comments entered by PR personnel as the game is played.

This screen is not used by data entry personnel in this version of GSIS.
Chapter 3

Pre-game Setup

This chapter contains procedures for all of the tasks you will perform prior to the start of the game.

Editing the Rosters

**Introduction**

GSIS automatically generates the game day roster. This information is downloaded from the Distribution Center. Prior to the start of the game, you must validate and correct all roster information.

**Displaying the Rosters/Starters Screen (Shift+F1)**

Display the Rosters/Starters screen in one of the following ways:

- Press `<Shift+F1>`.
- Click the **Roster/Starters** icon from the Set Up portion of the Navigation bar.
- Select **Rosters/Starters** from the **Go** menu.

The Rosters/Starters screen appears.

![Figure 20: Rosters/Starters Screen](image)

---

**Figure 20: Rosters/Starters Screen**
Chapter 3: Pre-game Setup

Editing the Rosters

Updating Player Information (Alt+I)
The information displayed on the Player Info tab refers to the highlighted player on the roster. The team icon, located at the top left of the tab, indicates to which team the player belongs.

To update player information:
1. Use the <↑> and <↓> keys to highlight the player from the team roster.
   The current information for that player is displayed in the Player Info tab.
   
   ```
   Press <Alt+I> if this tab is not currently being displayed.
   ```
2. Use the <Tab> key to highlight the information to be changed and type the correct information, and select the correct status from the Player Status drop-down list.
3. Press <Alt+S>, click Save, or press <Enter>. The information for that player is updated on the team roster.
   
   ```
   Pressing the <Page Up> and <Page Down> keys will move you backward and forward through the roster list ten players at a time.
   ```

Correcting Invalid Rosters

A valid roster is necessary for proceeding to other areas of GSIS. For example, duplicate uniform numbers could exist if an acquired player has a number that has already been used by another player on the roster. This situation will create an invalid roster.

These duplicate uniform number conditions are displayed in the Roster Status area of the Player Info tab.

To correct an invalid roster:
1. Press <Alt+H> or <Alt+V> to access the home or visitor roster, respectively.
2. Use the <↑> and <↓> keys to highlight one of the players with a duplicate uniform number from the team roster.
   The current information for that player is displayed in the Player Info tab.
3. If the player was acquired, change the jersey number to the uniform number the player uses on the new team. In some preseason games, multiple players may share the same jersey number.

   The first player with a shared uniform number gets the number, and subsequent players get the uniform number plus a letter suffix. Example: Player 1 and Player 2 both share #11. You would enter ‘11’ for Player 1, and ‘11A’ for Player 2. If Players 3 and 4 also have 11 as their uniform number, you’d enter ‘11B’ for Player 3 and ‘11C’ for Player 4.
4. Press <Alt+S>, click Save, or press <Enter>. This will remove the invalid uniform number message from the Roster Status area for that player.

You enter the three character uniform number on the Game Play screen in the same way:

<table>
<thead>
<tr>
<th>Code</th>
<th>Event/Attribute</th>
<th>Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL</td>
<td>Play from Scrimmage</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Possession</td>
<td>ARZ</td>
</tr>
<tr>
<td></td>
<td>Down</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Yards to Go</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Yard Line</td>
<td>ARZ 29</td>
</tr>
<tr>
<td></td>
<td>Start Time of Day</td>
<td>15:46:05</td>
</tr>
<tr>
<td></td>
<td>Start Time</td>
<td>07:39</td>
</tr>
<tr>
<td></td>
<td>End Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hash</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Formation</td>
<td></td>
</tr>
<tr>
<td>INC</td>
<td>Pass Incompletion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Passed by</td>
<td>11A - Two, Player</td>
</tr>
<tr>
<td></td>
<td>Intended Receiver</td>
<td>11B - Three, Player</td>
</tr>
<tr>
<td></td>
<td>Defended by</td>
<td></td>
</tr>
<tr>
<td>END</td>
<td>End of Play</td>
<td>ARZ-3-11-ARZ 28</td>
</tr>
</tbody>
</table>

The alphabetical suffix assigned to duplicate uniform numbers can be any letter in the alphabet, and does not have to be consecutive letters. In the example above, ‘11F’ or ‘11X’ are allowed uniform number assignments for Player 4.

Only the numeric portion of the three character uniform number is printed in the starters and substitutions sections of the front page of the gamebook. The four players above with uniform number 11 will be listed as all having uniform number 11, not 11, 11A, 11B, and 11C.

If the ‘Include Uniform Numbers’ option in the Report Options section is checked, the complete uniform number with the alphabetical letter will...
Chapter 3: Pre-game Setup

Editing the Rosters

be printed on the play-by-play report.

☐ A uniform number cannot contain more than three characters.

Acquiring a Player (Alt+A)

If a player is missing from the team's game roster, the player will need to be acquired.

This procedure is used when the player has previously played in the NFL. In the event that the player has not previously played in the NFL, see Adding a New Player in this chapter.

To acquire a player:

1. Press <Alt+A> or click Acquire Player. The Acquire a Player window appears.
Chapter 3: Pre-game Setup

2. Select the club from which the player was acquired from the Club drop-down list.

   The drop-down list is letter-sensitive; therefore entering the first letter of the team name will position the cursor at the first entry in the list that begins with that letter.

3. Select the Include Inactive checkbox to include all inactive players as well as those who are currently active.

4. Enter the last name or first few letters of the last name and press <Alt+G>, click Acquire Player, or press <Enter>.

   A list of players matching the entry is displayed.

   Clicking Acquire Player without entering a player name will display the entire team roster.

5. Use the <↑> and <↓> keys to highlight the player to be acquired.

6. Press <Enter> or click OK to enter the player's information in the Player Info tab or click Cancel to return to the Player Info tab without displaying the player's info.

7. Complete the remaining information for that player, and press <Alt+S>, click Save, or press <Enter> to update the roster with the acquired player.

When there are several players with the same name visible in the Acquire Player list, use the information in the birth date and school columns to match the right player on the list to the one on the team. The back of the flip card will have each player's birth date and school for you to reference.

---

Adding a New Player (Alt+N)

This option should only be used if a player is not available for acquisition; in other words, the player has not previously played in the NFL and does not currently exist on any NFL roster. If a player has previously played in the NFL, refer to Acquiring a Player in this chapter.

To add a new player:

1. Press <Alt+N> or click New Player.

   The information on the Player Info tab is removed. The text New Player appears to the right of the Uniform Number field.
Chapter 3: Pre-game Setup

Editing the Rosters

2. Enter the information for the new player and select the player’s status from the **Player Status** drop-down list.

3. Press <Alt+S>, click **Save**, or press <Enter>. The team roster is updated accordingly.

   If the first and last name you enter matches a name on an existing NFL team, the Player Search dialog will appear.
Changing a Player’s Status

The Player Status field determines where a player is listed in the game summary report. Players without a status entry will not be listed in the gamebook. You can give each player on a team one of the following statuses:

- **P** – Played
- **X** – Did not play
- **I** – Injured – Did not play
- **N** – Not active
- **R** – Injured Reserve

To change a player’s status:

1. Use the `<↑>` and `<↓>` keys to highlight the player from the team roster.
2. Select the appropriate status from the **Player Status** drop-down list on the **Player Info** tab.

   This new status appears in the roster list **Status** field for that player.

In the event that a status has not been assigned to several players on a team roster, you can update all of them at one time to a status of **Played** using the **All Played** button.

To apply the status of **Played** to all players who currently have no status:

1. Press `<Alt+P>` or click **All Played**.

   The following confirmation prompt appears.
Chapter 3: Pre-game Setup

Editing the Rosters

**Official Player Positions**

The Official Positions are used by NFL league computer systems. Every player must have at least one position recorded in order for the game to be closed post-game. Players who play more than one position should have all relevant official positions marked.

Official player positions will be **pre-filled** in the following ways:

1. They will carry over from week to week
2. When the position field (from the original screen) is entered, the system will attempt to match this position to one in the official list.

When making manual entries to the official positions, you should use the positions that appear on flip card as a guide. For example, if OL appears on the flip card rather than Center, you should mark the player as an Offensive Lineman.

**Deleting a Player from the Roster (Alt+D)**

To delete a player from the roster:

1. Use the `<↑>` and `<↓>` keys to highlight the player you want to delete from the team roster.
2. Press `<Alt+D>` or click **Delete Player**.

The following confirmation prompt appears. The prompt you see will include the uniform number and name of the player that you selected in Step 1.

---

**Figure 24: Mark as Played Prompt**

2: Click **Yes** to mark all players on the roster whose status is *No Status* with a status of *Played*, or click **No** to return to the **Player Info** tab without changing the roster.

We recommend that you first set the appropriate status for each player who did not play in the last game (for example, *Injured – Did Not Play* or *Not Active*). When you are finished, use the **All Played** button to set all remaining players’ statuses to *Played*.
3. Click **Yes** to remove the player from the roster, or click **No** to return to the **Player Info** tab without changing the roster.

   ‡ *If you accidentally delete a player, you can use the Acquire Player function to make the correction. See Acquiring a Player for details.*

   ‡ *If the focus is on the player list, you can press **<Delete>** to delete the highlighted player from the roster.*

### Depth Charts

Like starter information, depth chart information will be automatically generated on game day based upon the depth information from the previous week. The GSIS data operator will be required to make the necessary changes so that the information **matches** the depth information printed on the flip card distributed within the stadium on game day. This information is used to produce a flip card report at the Distribution Center that will be distributed to all NFL clubs. The flip card report can also printed at the stadium from the GSIS application.

The depth chart extends to 3 columns. If the flip card from which you are entering information contains a 4th column, you should enter the 4th column as shown below for the WR position:

<table>
<thead>
<tr>
<th>Position</th>
<th>#</th>
<th>Player</th>
<th>#</th>
<th>Player</th>
<th>#</th>
<th>Player</th>
</tr>
</thead>
<tbody>
<tr>
<td>WR</td>
<td>61</td>
<td>B. Engram</td>
<td>00</td>
<td>D. White</td>
<td>02</td>
<td>E. Kennison</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ST</td>
<td>78</td>
<td>B. Brodermann</td>
<td></td>
<td></td>
<td>90</td>
<td>V. Tuinei</td>
</tr>
<tr>
<td>LG</td>
<td>75</td>
<td>T. Perry</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>57</td>
<td>O. Kreutz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RG</td>
<td>58</td>
<td>C. Willerial</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RT</td>
<td>71</td>
<td>J. Williams</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TE</td>
<td>65</td>
<td>A. Mayes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WR</td>
<td>88</td>
<td>M. Robinson</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To enter information into the depth chart, click inside one of the white cells. Enter the player's uniform number, and GSIS will supply the player's name when you leave the cell. You can navigate the grid either by mouse or the arrow keys.

### Coaches

Coach information will be generated automatically on game day. The GSIS data entry operator is responsible for making any updates necessary so that the data matches that on the printed flip card report.
To add a new coach, click on the New Coach button, and enter the coach’s name and title. Press <Enter> or click the Save button when done. To edit or delete a coach, select the coach’s name from the list and click on the appropriate button.

You can click on the Acquire All button to add all the coaches for the team in one action.

Editing Player Defaults

Introduction

The player defaults information is downloaded from the Distribution Center along with the rosters and starters. This information is based on what was entered during the last game played by the team. You should make changes to player defaults prior to the start of the game.

In order to facilitate the play entry, you may assign a player from each team to a position that will be used as a default for specific events and attributes. The Player Defaults screen displays the home and visitor defaults side-by-side.

Displaying the Player Defaults Screen (Shift+F2)

Display the Player Defaults screen in one of the following ways:

- Press <Shift+F2>.
- Click on the Player Defaults icon from the Navigation bar.
- Select Player Defaults from the Go menu.

The Player Defaults screen appears.
Assigning a Player Default

1. Use the <Tab> key or press <Alt+H> or <Alt+V> to access the home or visitor default list, respectively.

   - The team name will be displayed in **bold** when the list is active.

2. Use the <↑> and <↓> keys to highlight the default position.
3. Type the uniform number of the player to be assigned as the default.
   The player's name will be displayed at the top of the default list.
4. Press <Enter>.
   The player's name and uniform number will appear next to the selected position and the next position will be highlighted.
Chapter 4

Game Play

This chapter provides procedures for entering game play information and displaying statistics.

Entering Plays

Introduction

Entering plays quickly and accurately is the most important aspect of using GSIS. This section describes the function keys and keyboard shortcuts that you use to enter plays.

There are additional shortcuts that relate to specific areas of GSIS. These are explained in the corresponding sections of this guide.

Play Entry

Function Keys

The function keys are located across the top of the keyboard. The following list describes the function keys that have been assigned to specific activities.

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;F1&gt;</td>
<td>Display the keyboard shortcuts window.</td>
</tr>
<tr>
<td>&lt;F2&gt;</td>
<td>Insert an event before the selected event.</td>
</tr>
<tr>
<td>&lt;F3&gt;</td>
<td>Delete the selected event.</td>
</tr>
<tr>
<td>&lt;F4&gt;</td>
<td>Display the Choices window.</td>
</tr>
<tr>
<td>&lt;F5&gt;</td>
<td>Change the play list display.</td>
</tr>
<tr>
<td>&lt;F6&gt;</td>
<td>Edit play statistics and enter manual stats for a play.</td>
</tr>
<tr>
<td>&lt;F7&gt;</td>
<td>Go to the previous play.</td>
</tr>
<tr>
<td>&lt;F8&gt;</td>
<td>Go to the next play.</td>
</tr>
<tr>
<td>&lt;F9&gt;</td>
<td>Place GSIS in Auto-Scroll mode.</td>
</tr>
<tr>
<td>&lt;F11&gt;</td>
<td>Set the start time attribute of a play with the game clock.</td>
</tr>
</tbody>
</table>
Play Entry Keyboard Shortcuts

The following list describes the key combinations that have been assigned to specific activities:

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Ctrl+F2&gt;</td>
<td>Insert a play before the selected play.</td>
</tr>
<tr>
<td>&lt;Ctrl+F3&gt;</td>
<td>Delete the selected play.</td>
</tr>
<tr>
<td>&lt;Ctrl+F7&gt;</td>
<td>Go to the previous open or flagged play.</td>
</tr>
<tr>
<td>&lt;Ctrl+F8&gt;</td>
<td>Go to the next open or flagged play.</td>
</tr>
<tr>
<td>&lt;Ctrl+F11&gt;</td>
<td>Set the start time of day attribute of a play with the game clock.</td>
</tr>
<tr>
<td>&lt;Ctrl+E&gt;</td>
<td>End the current play.</td>
</tr>
<tr>
<td>&lt;Ctrl+F&gt;</td>
<td>Show the play search screen.</td>
</tr>
<tr>
<td>&lt;Ctrl+G&gt;</td>
<td>Flag the current play.</td>
</tr>
<tr>
<td>&lt;Ctrl+N&gt;</td>
<td>Start a new play.</td>
</tr>
<tr>
<td>&lt;Ctrl+Enter&gt;</td>
<td>End the current play, create a new play.</td>
</tr>
<tr>
<td>Pg Up</td>
<td>Move to the previous event within a play.</td>
</tr>
<tr>
<td>Pg Dn</td>
<td>Move to the next event within a play.</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Reposition an event in the current play.</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Redefault the play attributes (down, distance, possession, start time).</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Show the Find Plays search window in Error mode, and perform a search for errors and warnings.</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Show the next play’s defaults in a tooltip.</td>
</tr>
</tbody>
</table>

The following are additional topics that relate to entering plays.

Auto Complete
In order to facilitate the entry of data into GSIS, the system automatically completes an entry with currently valid data. For example, when entering an event, you need type only the first letter(s) of that event’s smart code in order to have the entire event display in the Data Entry field.
This facility can also be used to complete the value for an attribute. For example, typing the player number automatically completes the attribute value with the player's name.

**Yard Line Entry**
When entering a yard line, there are a few basic rules that will help expedite entry. First, if the attribute already has a team code (MIA23), and the ball has not crossed midfield, you do not need to type in the team code again. This is illustrated in example 1.

**Example 1:** Miami has possession of the ball at the MIA23. A Miami player rushes the ball and is tackled at the 28-yard line for a 5-yard gain. The Yard Line attribute of the Tackle event will default to MIA23. Typing a 28 into that field will change the yard line to MIA28.

What if the ball crosses midfield? In this case, it is necessary to type in either the new team code, or an h for home or v for visitor. In example 2, Miami is the Home team and the New York Jets are the visiting team.

**Example 2:** Miami has possession of the ball at their own 40-yard line. A Miami player rushes the ball and is tackled 15 yards downfield. The Yard Line attribute of the Tackle event will default to MIA45. You will have to enter either NYJ45, or v45. This will make the new attribute value NYJ45.

In the case where the ball is at midfield, it is not required to put the team code or the h/v in front of the yard line. The system will accept 50 as a valid yard line. The system will also accept either team’s club code, h, or v in front of the 50.

**Player Entry**
The same rules for specifying the team that apply to yard line entry also apply to entering player numbers for the Fumble event (Recovered by attribute) and the Penalty event (Player attribute).

---

**Starting the Game (Game Event)**

The first event of the game is the Game event. It is automatically generated at the beginning of the game.

**Entering Pre-game Information**

Some fields in the Game event contain default entries that are downloaded from the league offices. The following fields are blank and need to be completed.
Chapter 4: Game Play

Entering Plays

- Home Head Coach
- Visitor Head Coach
- Stadium
- Location
- Stadium Type
- Turf Type
- Time Zone
- Game Start Time (24-hour clock)
- Game Weather
- Temperature
- Humidity
- Wind Speed
- Wind Direction
- Wind Chill
- Outdoor Weather
- Club Won Coin Toss
- Elects
- Other Club Elects
- Game Home/Neutral
- Paid Attendance
- Referee
- Umpire
- Head Linesman
- Line Judge
- Field Judge
- Side Judge
- Back Judge
- Replay Official
- Game Summary Aux Title

Refer to Entering an Event and Entering an Attribute Value for information on completing these fields.

Entering an Event

To enter an event:

1. Use the <Tab> key to access the Data Entry field. A green arrow to the left of the Data Entry field indicates that it is active.

2. Use one of the following methods to enter the event:
   - Type the smart code of the new event. If a default has been entered for the event, it will automatically display.
   - Press <Alt+↑> to select the event from the Data Entry field drop-down list.
   - Press <F4> to select the event from the Choices window.

3. Press <Enter> to save the event. The event that you selected appears in the Events and Attributes window, and the system automatically positions the highlight bar on the first required attribute for that event.

Entering an Attribute Value

After you have entered the event, the system automatically positions the highlight bar on the first required attribute for that event.

You enter an attribute in much the same way that you enter an event. In some cases, attributes will have a code associated with them (for example, players have uniform numbers). In other cases (for example, yard lines), only a value is required. The system will validate the attribute value based on the type of the attribute.

To enter an attribute:

1. Use one of the following methods to enter an attribute for an event:
   - Type the code for the appropriate attribute type. If a default attribute value has been entered, it will automatically display.
• Press <Alt+↓> to select the attribute value from the Data Entry field drop-down list.
• Press <F4> to select the attribute value from the Choices window.

2. Press <Enter> to save the attribute value. The attribute value that you selected appears in the Events and Attributes window, and the system automatically positions the highlight bar on the next required attribute, or the next event if this was the last attribute for the current event.

Basic Play Entry

Each play begins with an initial event that is based on the results of the previous play. For example, after a play has been completed with a tackle, the next play will begin with a Play from Scrimmage. This is the default that is presented when you end the current play and begin a new play (press <Ctrl+Enter>). You can change this event by selecting one of the other valid events listed in the Choices window.

The following is a list of valid starting events:

<table>
<thead>
<tr>
<th>Play</th>
<th>Smart Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>CO</td>
</tr>
<tr>
<td>End of Play</td>
<td>END</td>
</tr>
<tr>
<td>End of Game</td>
<td>ENDGM</td>
</tr>
<tr>
<td>End of Quarter</td>
<td>ENDQ</td>
</tr>
<tr>
<td>Fair Catch Kick</td>
<td>FCK</td>
</tr>
<tr>
<td>Free Kick</td>
<td>FK</td>
</tr>
<tr>
<td>Play from Scrimmage</td>
<td>PL</td>
</tr>
<tr>
<td>Timeout</td>
<td>TO</td>
</tr>
<tr>
<td>Try for Extra Point(s)</td>
<td>XP</td>
</tr>
</tbody>
</table>

The type of play you choose determines which events will be available for selection. For example, if you choose an Incomplete Pass event, the next event selection will contain a Comment, End of Play, or Penalty; the field cannot contain any other value. However, if a Rush event is chosen, different events will be available such as Fumble, Lateral, Tackle, and so on.

Entering a Play

The following is an example of how to enter a rushing play.

1. Press <Ctrl+Enter> to end the current play and begin the next play. The following screen appears.
You can also add a new play by pressing the <Enter> key twice at the End of Play event.

<table>
<thead>
<tr>
<th>Events and Attributes</th>
<th>Possession: TB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seq</td>
<td>Code</td>
</tr>
<tr>
<td>1</td>
<td>PL</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>NE</td>
</tr>
</tbody>
</table>

Figure 29: Play Entry Example Screen 1

Certain information has been entered by GSIS. This information includes the team that has possession of the ball, the yard line, the current down, and the yards to go for a first down. This information can be changed by highlighting it and entering the correct information.

You can have GSIS recalculate the play defaults for a play by pressing <Ctrl-R>. This is useful when a play is inserted, or when a play is updated in such a way that the play-type attributes for the succeeding play are no longer correct.

2. Select the next event in one of the following ways:
   - Press <Enter> to accept the default for the next event.
   - Press <F4> to select the next event from the Choices window.
   - Enter the first few characters of the event’s smart code in the Data Entry field and press <Enter>.
   - Select the event from the Data Entry field drop-down list.

For this example, we selected the default Rush event. The Events and Attributes window changes to show the Rush event, and the highlight bar is positioned on the first required attribute for this event, Tackled by.
3. Select the player who rushed in one of the following ways:
   - Enter the player's jersey number in the **Data Entry** field and press `<Enter>`.
   - Press `<F4>` and select the player from the Choices window.
   - Select the player from the **Data Entry** field drop-down list.

   The **Rushed by** attribute field is filled in with the player you selected in Step 3, and the highlight bar is positioned on the next attribute, in this case, **Direction**.

4. Select the direction the player rushed in one of the following ways:
   - Enter the first few characters of the direction in the **Data Entry** field and press `<Enter>`.
   - Press `<F4>` and select the direction from the Choices window.
   - Select the direction from the **Data Entry** field drop-down list.

   Defaults will be entered in certain fields based on entries made on the Player Default screen. Refer to Player Defaults, in Chapter 2, for more information.

5. Select the next event using one of the methods described in Step 2.

   For this example, we selected the default **Tackle** event. The Events and Attributes window changes to show the **Tackle** event, and the highlight bar is positioned on the first required attribute for this event.
6. Select the player who made the tackle in one of the following ways:
   - Enter the player's number in the Data Entry field and press **<Enter>**.
   - Press **<F4>** to select the player from the Choices window.
   - Select the player from the Data Entry field drop-down list.

7. Enter the new yard line, if necessary, and press **<Enter>**. The highlight bar is positioned on the next event.
If the yard line is in the same team’s zone as the previous yard line, you need enter only the yard number. For example, on this screen the play began at the Tampa Bay 35. The play ended at the Tampa Bay 44 (for a 9-yard gain). To make this change, you need only enter 44 in the Yard Line attribute of the Tackle event.

You can enter the letters h or v instead of the 3-character team code to indicate the home or visitor team zone.

8. Select the default **End of Play** event. The Events and Attributes window now looks like this.
These steps complete a simple rushing play. Although plays can be made complex by the addition of fumbles, penalties, and so on, all plays are entered in this manner.

Setting the Play Start Time (F11)

To set the play start time, press <F11> or choose Play Start Time from the Actions menu.

This sets the Start Time attribute of the current play with the time from the game clock. It will also set the Start Time of Day attribute with the system time from the laptop.

The game clock time is visible on the Section bar. It’s visible on every laptop. If one laptop in the network has a functioning game clock interface, it will relay the clock signal to the other laptops.

The game clock value is normally black. If it turns red, then a signal from the game clock has not been received in the last 10 seconds. You should contact the stadium technician for assistance when this happens.

GSIS will use the relayed clock signal value when the F11 key is pressed if the laptop doesn’t have a short haul modem connected to it. If no laptop has a functioning game clock interface, the prompt to enter the start time will appear when the F11 key is pressed. The Start Time of Day attribute will still accept the time.

Setting the Start Time of Day (Ctrl+F11)

To set the start time of day, press <Ctrl+F11>.

This function will set the Start Time of Day attribute of the current play with the time from the system clock of the laptop.

Setting the Play

This function is used when the game clock is connected to the GSIS.
End Time (F12)

To set the play end time, press <F12> or choose Play End Time from the Actions menu.

This sets the End Time attribute of the current play with the time from the game clock. This should be used primarily on the last play of a drive, but can be used every time a play ends.

Warning: If the game clock is not properly connected to the laptop, you will receive an error message informing you of the problem. Please call the stadium technician to resolve the problem.

Inserting a Play Before the Selected Play (Ctrl+F2)

When you insert a play, it appears in the play list before the play that you select.

To insert a play:

1. Select the play from the play list or the Events and Attributes window.
2. Press <Ctrl+F2> or choose Insert Play from the Actions menu.
3. Enter the events and attributes of the play.

Ending the Current Play (Ctrl+E)

To end the current play, press <Ctrl+E>, choose End Play from the Actions menu, or choose End Play as an Event and press the <Enter> key. Ending the current play does not create a new play.

Ending the Current Play and Creating a New Play (Ctrl+Enter)

You can end the current play and create a new play in one step.

To end the current play and create a new play, press <Ctrl+Enter> or choose End & New from the Actions menu. You can also press the <Enter> key twice on the End Play event to add a new play.

Creating a New Play (Ctrl+N)

When you create a new play, the current play remains open. We recommend that you end the current play before you begin a new one. For example, press <Ctrl+E> to end the current play, then press <Ctrl+N> to begin a new one, or press <Ctrl+Enter> to end the current play and begin a new one in one step.

The last play in the game needs to be ended for GSIS to calculate the play defaults on the new play. It takes much less time to enter a play that has the starting yard line, possession team, down, and distance entered by the system.

Change of Possession

When the ball changes possession, GSIS prompts you to enter the play end time if you haven’t done so before ending the play.

Crossing Midfield

When the ball crosses midfield, you must enter either the new team code, or an h for home or v for visitor.

In the case where the ball is at midfield, it is not required to put the team code or the h/v in front of the yard line. The system will accept 50 as a valid yard line.
You can search for a particular play in the play list.

To find a play:

1. Press \(<\text{Ctrl+F}\) or select \(\text{X}\) from the toolbar. The Find Plays dialog appears.

![Find Plays Dialog](image.png)

2. Enter or select the desired search criteria. If you select more than one item, the system will perform the search on both items (a logical AND condition). For example, if you select a team from the **Team Code** drop-down list and click the **Fumbles** checkbox, the system will find only those plays in which the selected team has fumbled the ball.

3. Click **Find Now**. The dialog expands to display the play(s) that satisfy your search criteria.
Clicking on a play displays that play in the Events and Attributes window and highlights the play in the play list.

You can also perform an advanced search to further define the search.

To perform an advanced search:

1. Click **Advanced Search** from the Find Plays dialog. The dialog changes to display the advanced search features.
2. Enter or select the desired search criteria.
3. Click **Find Now**. The dialog expands to display the play(s) that satisfy your search criteria.

   Clicking on a play displays that play in the Events and Attributes window and highlights the play in the play list.

   You can also show the Find Plays window in Advanced Search mode by pressing <Ctrl-W>, or by choosing Find Plays w/ Warnings, Errors from the Actions menu. This both shows the Find Plays window and performs an advanced search with the Any Warning, Any Error, Open Plays, and Flagged Plays, Unread options checked.

**Correcting a Play**

It may become necessary to make corrections to a play that has already been entered. This can be done by either inserting, deleting, or moving individual events, or by inserting or deleting entire plays.

**Flagging a Play**

GSIS provides the capability to flag a play.

To flag a play:

1. Press <Ctrl+G>. The Flag a Play dialog appears.
Chapter 4: Game Play

Entering Plays

2. To enter a new flag, type in the flag comments, and press <Enter>. To clear the current flag, press <Alt+R> or click Clear Flag. After the play flag is saved, a yellow flag icon will appear next to the play in the play list. After you read a flag, the flag’s color changes to black. There is a tool tip on the icon on the play list that displays the first 80 characters of the comment.

The number of flagged plays shows in the status bar to the right of the number of open plays. If there are any unread flags, the count shows as Total/Unread with a yellow flag icon. If all flags have been read, the total shows with a black flag icon.

Moving Between Open Plays and Flagged Plays (Ctrl+F7 and Ctrl+F8)

In GSIS, you have the ability to move between open and flagged plays.

To move to the previous play that is either open or flagged, press <Ctrl+F7>.

To move to the next play that is either open or flagged, press <Ctrl+F8>.

Pressing <Ctrl-W> to do an Advanced Search will show all flagged plays in the Search Results list. You can click on plays in the Search Results window to directly navigate to that play.

Deleting a Play (Ctrl+F3)

When you delete a play, you also delete all of that play’s events and attributes.

To delete a play, press <Ctrl+F3>, or choose Delete Play from the Actions menu.
Inserting an Event Before the Selected Event (F2)

When you insert an event, it appears before the event that you select. For example, if you select the third event in a play, the new event will become the third event and all subsequent event numbers, including the selected event, will increment by one.

To insert an event:
1. Select the event from the Events and Attributes window.
2. Press <F2> or choose Insert Event from the Actions menu.
3. Enter the attributes of the event.

You can also select an attribute that is contained in the event before which you want the new event to appear.

Deleting an Event (F3)

To delete an event:
1. Press <F3> or choose Delete Event from the Actions menu. A confirmation prompt appears.
2. Click Yes to delete the selected event or click No to return to the Game Play screen without deleting the event.

Pressing <F3> while an attribute is highlighted will delete the event in which the attribute is contained. You do not have to navigate up to the event to delete the event.

Moving an Event (Ctrl-M)

To move an event from one place in a play to another place in the play, do the following:

1. Highlight the event that you want to move.
2. Press the <Ctrl-M> keys, or choose Move Event from the Actions menu. The Move Event dialog appears.

![Move Event Dialog](image)

3. Enter the sequence number of the event before which the selected event is to be moved.

   The sequence number is located to the left of the event code on the Events and Attributes Window in the Seq column.

4. Press <Enter> or click OK to move the event, or press <Esc> or click...
Chapter 4: Game Play

Entering Plays

**Cancel** to return to the Events and Attributes window without moving the selected event.

- Pressing `<Ctrl-M>` while an attribute is highlighted will move the event in which the attribute is contained. You do not have to navigate up to the event to perform a move.

### Using the Choices Window (F4)

The Choices window displays all of the available selections for the highlighted event or attribute.

#### Displaying the Choices Window

To display the Choices window, press `<F4>` or choose Choices Window from the Actions menu.

The following screen shows the list of choices that are displayed for the **Tackled by** attribute.

![Figure 39: Choices Window](image)

- You can toggle between the Choices window and the Events and Attributes window by pressing `<F4>`.
Chapter 4: Game Play  
Entering Plays

Selecting an Entry from the Choices Window
To select an entry from the Choices window:

1. Select an entry in one of the following ways:
   - Press <↑> and <↓> to move within the list of choices until you find the desired entry.
   - Enter the first letter of the entry that you wish to find, for example if you want to find a player whose last name begins with a C, press <C>. The highlight bar is positioned on the first player whose last name begins with a C.

2. Click Apply or press <Enter>.
   The entry you selected displays in the Value Description field of the Events and Attributes window and the next event is highlighted.

Using the Find Field
The Choices window has the ability to narrow down the choices that are displayed. This is useful for large lookups such as the Penalty attribute. Entering values in the Find field will narrow down the choices to only items that contain the characters that are entered. For example, if you enter the characters han, entries that contain only the characters han will be displayed.

Printing the Choices Window
To print the contents of the Choices window, press <Alt+P> or click Print.

Entering a Play Comment
You may enter a comment on the Next Event prompt anywhere in a play.

To comment on a play:

1. Use one of the following methods to enter the comment event:
   - Press <F4> to display the Choices window and select Comment from the list.
   - Enter CO in the Data Entry field and press <Enter>.

2. Enter the comment text in the Data Entry field.
3. Press <Enter>.

Injury comments and Player Reporting in as Eligible comments work the same was the generic comment.

Editing Play Statistics (F6)
In some cases, it may become necessary to manually override the play statistics that GSIS calculates. You should override play statistics only when the head statistician is absolutely sure that the calculated stats are incorrect. It is a good idea to verify the rule in question in the Guide for Statisticians before doing so.

⚠️ You cannot modify the statistics for an open play.
Displaying the Play Statistics Dialog

To display the Play Statistics dialog:

1. Select the play from the play list that contains the statistics you want to override.
2. Press <F6> or choose Play Statistics from the Actions menu. The Play Statistics screen appears.

![Figure 40: Play Statistics Dialog](image)

- It is not necessary to click the **Stats manually modified** checkbox to begin modifying play stats. When the first change is made on the screen, this checkbox will automatically be checked.

Updating Play Statistics

To update the play statistics:

1. Select the **Stats Manually Modified** checkbox to indicate that the stats are being manually modified.
2. Select the element of the play that you want to update, for example the **Player**, and select a valid entry from the drop-down list associated with that field, or enter the updated data.
3. Press <Enter> or click Update to make the change.
4. Press <Alt+S> or click Save or to save the change(s) and display the Game Play screen.

Modifying the play stats will not change the events and attributes of a play; it will change only the calculated stats.

Upon returning to the Game Play screen, an updated stats indicator will appear in the play stats area to indicate that the current play contains updated stats. Figure 41 shows the play stats area with the updated stats indicator in the Desc field.

<table>
<thead>
<tr>
<th>Plyr</th>
<th>Yds</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>NYG 47</td>
<td>0</td>
<td>Solo Tackle</td>
</tr>
<tr>
<td>TB</td>
<td>37</td>
<td>1st Down Passing</td>
</tr>
<tr>
<td>TB 12</td>
<td>37</td>
<td>Passing Yards</td>
</tr>
<tr>
<td>TB 25</td>
<td>37</td>
<td>Pass Reception Yards</td>
</tr>
</tbody>
</table>

Figure 41: Updated Stats Indicator

Adding Statistics to a Play
To add statistics to a play:

1. Select the Stats Manually Modified checkbox to indicate that the stats are being manually added.
2. Click New.
3. Enter the player, yards, statistic and stat type of the new statistic. Press <Enter> or click Update to store the changes.
4. Press <Alt+S> or click Save or to save the change(s) and display the Game Play screen.

Removing Statistics from a Play
To remove statistics from a play:

1. Highlight the statistics to be removed.
2. Press <Alt+R> or click Remove.
3. Press <Alt+S> or click Save or to save the change(s) and display the Game Play screen.

Removing All Override Statistics from a Play

To remove all override statistics from a play:

If it becomes necessary to remove all override stats from a play and revert back to the calculated stats, use the following procedure:

1. Press <Alt+M> or click the Stats manually modified check box. Make sure the check mark is cleared from the check box.
2. Press <Alt+S> or click Save or to save the change(s) and display the Game Play screen.

Displaying the Play List

To display the play list, press <Alt+L>.

You can expand the width of the Play List window by pressing the <F5> key, or by choosing Change Display from the Actions menu. This will hide the scoreboard, allowing you to see more of each play’s play by play text. Pressing <F5> again will shrink the Play List to its original width.

The play list contains all of the plays that have occurred in the game. Use the following keystrokes to navigate the play list.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;↑&gt;</td>
<td>Move up one play in the play list.</td>
</tr>
<tr>
<td>&lt;↓&gt;</td>
<td>Move down one play in the play list.</td>
</tr>
<tr>
<td>&lt;Home&gt;</td>
<td>Go to the first play of the game.</td>
</tr>
<tr>
<td>&lt;End&gt;</td>
<td>Go to the last play of the game.</td>
</tr>
<tr>
<td>&lt;1&gt;</td>
<td>Go to the first play of the first quarter.</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Go to the first play of the second quarter.</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Go to the first play of the third quarter.</td>
</tr>
</tbody>
</table>
Chapter 4: Game Play

Displaying a Play Description

To display a play description, press <Alt+D>.

<table>
<thead>
<tr>
<th>Play List</th>
<th>Play Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.Kelly up the middle to TB 44 for 9 yards (P.Ellsworth).</td>
<td></td>
</tr>
</tbody>
</table>

Figure 43: Play Description

The Play Description tab displays the play-by-play for the play that has been highlighted in the play list. If there are any errors in the play data entry, they will be displayed in this window in red.

Refreshing the Game Play Screen (Ctrl-F5)

Although the system automatically refreshes the screen, pressing the refresh key will guarantee that your screen displays exactly what is in the database at that time.

To refresh the Game Play screen, press <Ctrl-F5>, or choose Refresh from the Tools menu. Your position in the Play List will stay the same.

Auto-Scroll Mode (F9)

Auto-scroll is toggled on/off by pressing the F9 key. When auto-scroll is on, you are automatically repositioned on a new play when another user appends it, making this mode useful for auditing the data entry user's input. The repositioning occurs after the second event is added to the new play. An application option tells the system how long to wait for the second event before moving to the new play. For example, assume this option is set to 5 seconds. You are positioned on the last play in the game. Another user ends that play, and appends a new one. You will be repositioned on the new play when either a second event is added to it, or 5 seconds have elapsed, whichever occurs first. If the option is set to 0, scrolling occurs as soon as the new play is appended, and is the default option. If the option is set to –1, scrolling does not occur until the second event is added to the new play.

Auto-scroll is turned off when you press any key (with a few exceptions.)

<table>
<thead>
<tr>
<th>&lt;4&gt;</th>
<th>Go to the first play of the fourth quarter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;5&gt;, &lt;6&gt;, &lt;7&gt;, and so on</td>
<td>Go to the first play of the first OT, and so on</td>
</tr>
<tr>
<td>&lt;Pg Up&gt;</td>
<td>Move up approximately seven plays in the play list.</td>
</tr>
<tr>
<td>&lt;Pg Dn&gt;</td>
<td>Move down approximately seven plays in the play list.</td>
</tr>
</tbody>
</table>
Chapter 4: Game Play

Displaying Game Statistics

**Ending the Game (End of Game Event)**

The last event of the game is the *End of Game* event.

Enter the *End of Game* event to end the game.

**Displaying Game Statistics**

**Introduction**

GSIS presents game statistics in the following ways: *Drive Chart*, *Offensive Statistics*, *Defensive Statistics*, and *Team Statistics*. The following sections describe each method.

**Displaying the Drive Chart (Shift+F6)**

The drive chart contains the ball possession and drive statistics for both teams.

To display the drive chart, press <Shift+F6> or click the *Drive Chart* icon from the Navigation bar.

![Drive Chart](image)

*Figure 44: Drive Chart*

**Displaying Offensive Statistics (Shift+F7)**

The Offensive Stats screen contains the Rushing, Passing, and Receiving individual statistics for both teams.

To display the offensive statistics, press <Shift+F7> or click the *Offensive Stats* icon from the Navigation bar.
Chapter 4: Game Play

Displaying Game Statistics

Figure 45: Offensive Stats

Displaying Defensive Statistics (Shift+F8)

The Defensive Stats screen contains the individual defensive statistics for both teams.

To display the defensive statistics:

1. Press <Shift+F8> or click the **Defensive Stats** icon from the Navigation bar.
   
   The Defensive Stats screen appears.
Displaying Team Statistics (Shift+F9)

The Team Stats screen contains categorized full-team statistics for both teams.

To display the team statistics, press <Shift+F9> or click the Team Stats icon from the Navigation bar.
Displaying Kicking Statistics

The Kicking Stats screen contains categorized full-team statistics for both teams.

To display the kicking statistics screen click the Kicking Stats icon from the Navigation bar.

![Figure 47: Team Stats]

- **Place Kicking**
  - **New York Giants - Kicking Statistics**
    - | Name | FG | FG% | FGB | XP | YMP | PMP | Points |
    - | L. Tyler | 1 | 0 | 0 | 2 | 0 | 0 | 5 |
    - **Total:** | 1 | 0 | 0 | 2 | 0 | 0 | 5 |

- **Punting**
  - **Pineglen**
    - | Name | NUM | YDS | AVG | Net | LG | TB | TD | INDO |
    - | L. Pineglen | 4 | 156 | 36.0 | 35.3 | 55 | 0 | 2 |
    - **Total:** | 4 | 156 | 36.0 | 35.3 | 55 | 0 | 2 |

- **Kickoff Returns**
  - **N. H.**
    - | Name | NO | YDS | AVG | LG | TD | PC |
    - | N. H. | 2 | 39 | 19.5 | 25 | 0 | 0 |
    - **Total:** | 2 | 39 | 19.5 | 25 | 0 | 0 |

- **Punt Returns**
  - **R. M.**
    - | Name | NO | YDS | AVG | LG | TD | PC |
    - | R. M. | 3 | 25 | 8.3 | 16 | 0 | 0 |
    - **Total:** | 3 | 25 | 8.3 | 16 | 0 | 0 |

Scoring Summary Screen

The scoring summary screen displays the score summary from the front page of the game book on screen. To view it, click on the Go menu item and choose Scoring Summary or click on the Scoring Summary icon on the navigation bar.

Double-clicking on a row will take you to that scoring play on the Play Entry screen.

Displaying Notes

Introduction

The Notes screen is used by PR Personnel to enter comments about specific plays. It can also be used to add comments about records set on a play. Press <Shift-F11> to display the Notes screen.

Single-Game Record

GSIS can look for a number of single-game player and team records at both the club and League level and mark the...
Chapter 4: Game Play

Displaying Notes

Identification

record-setting play. The types of records GSIS can identify include most passing yards in a game, most rushing attempts in a game, longest field goal, and many others.

The Notes screen shows the list of plays in the game, a drop-down box to select the type of note to display, and a button to initiate the record search. There are two types of Notes in GSIS: PR Home notes and Record notes. A play can have both types of notes. If a play has a note of the selected type (the screenshot is listing Record notes), it will have an icon to the left of the play showing a piece of paper with a thumbtack. The touchdown play has a record note, the other 3 plays do not. To look for records, press the Get Records button. GSIS will search for records from all the plays in the game. Once the search is complete, you’ll get an alert telling you how many records were found, and the last play with a record will be selected. If a play has a record note already, it will not get a new note, and the existing note will not be changed.

You can check the Remove Existing Notes option before clicking on Get Records to have GSIS recalculate record text for all the plays. It’s recommended that you check this option when searching for records after the game is over. Using this option will not delete PR Notes.

You can modify the note text at any time. Select the play with the note.
Below the list of plays you’ll see the note text and edit buttons:
Chapter 4: Game Play

Displaying Notes

The note text is editable. You must click on the Save button to save any changes. Clicking on a different play in the list will not save any changes you have made since the last save point. Clearing the note will clear all the text in the box, clear the note icon from the play list, and delete the note from the database.

By default GSIS will look for the top five records in each category for record-setting performances. You can limit the number of records by clicking on the Tools menu, selecting Options, and then clicking on the Misc tab:

The example screenshot shows a modified search depth of 2, meaning GSIS will only look for performances that either set a club or League record, or were the second best performances. This setting applies to all record searches. You can’t look for the top 4 rushing attempt records and the top 2 field goal length records at the same time. You would have to set the Option to 4, do a record search, and clear out any field goal records that didn’t belong in the top 2 manually.

The Record note text can appear in the play by play. There is an option for including PR Notes in the play by play on the Reports tab of the Options screen. This setting, and the record search depth setting, persist between GSIS sessions and are machine-specific. If you want to include or exclude
PR notes from the gamebook you should review the setting before printing.

You must be logged in as the entry, audit, pr-home, or pr-visit user to use this feature.

---

### Printing Reports and Lists

#### Introduction

During a game, you will be required to print various reports at different times. For example, after the end of the first quarter, you will need to print the Quarter 1 Summary report for distribution within the press box.

#### Printing a Report

To print a report:

1. Press `<Ctrl+P>` or select **Print Reports...** from the **File** menu. The Print Reports dialog appears.

2. Click the checkbox to the left of each report that you wish to print. You can also use the `<↑>` and `<↓>` arrow keys to highlight the report that you want to print, then press `<Spacebar>`. You can print more than one report at the same time. You can also select the **Select all Game Book reports** check box. This will automatically select the first seven reports in the list. These are the reports that make up the game book.

   - If you select the **Play by Play** report, you will be prompted to enter additional options for the report. See Printing a Play by Play Report in this section.

3. Press `<Alt+P>`, click **Print**, or press `<Enter>`. The report(s) you checked are sent to the network printer.
Chapter 4: Game Play  Printing Reports and Lists

Printing a Report to a File

To print a report to a file:

1. Press <Ctrl+P> or select Print Reports... from the File menu. The Print Reports dialog appears.
2. Click the checkbox to the left of the report that you wish to print. You can print only one report to a file at a time.
   
   If you select the Play by Play report, you will be prompted to enter additional options for the report. See Printing a Play by Play Report later in this section.

3. Type the path and file name for the report in the Text File Output Directory text box.
4. Press <Alt+M> or click Make Text File. The report you checked is sent to the directory that you specified in Step 3.

Changing the Printer

GSIS will select the default printer for your machine when the Print Reports window is shown. If you have multiple printers set up, you can change which printer GSIS will print to by choosing a printer in the Printer drop-down list. Contact your stadium technician if you have a different printer available that isn’t listed.

Printing the Play-by-play Report for Selected Quarters

Selecting the play-by-play report requires that you define further options for the report.

To print a play-by-play report:

1. Press <Ctrl+P> or select Print Reports... from the File menu. The Print Reports dialog appears.
2. Click the checkbox to the left of Play By Play. The dialog expands to display these additional options.
3. Select the quarters that you want to appear in the report.

4. Press <Alt+P>, click Print, or press <Enter>. The reports are sent to the network printer.

You can also print a play by play that includes plays from the current drive only. The drive that will be printed is the one containing the play selected in the play list, whose events and attributes are being displayed. You can either print a play by play for a specific set of quarters, or a play by play for a specific drive.

If the Include Start Time of Day option is checked, the time of day the play started will be prepended to each play's text. The play by play report with time of day should not be distributed to the media in the press box as part of the gamebook, or faxed to Elias. It should only be produced upon request by the home club's scoreboard or video operations departments.

**Previewing a Report**

To preview a report on the screen:

1. Press <Ctrl+P> or select Print Reports... from the File menu. The Print Reports dialog appears.
2. Click the checkbox to the left of the report that you want to preview. You can preview only one report on the screen at a time.

   *If you select the Play by Play report, you will be prompted to enter additional options for the report. See Printing a Play by Play.*
3. Press <Alt+V> or click Preview... The report you checked is displayed on the screen. See the example below.

![Sample Report](image)

Figure 55: Sample Report

From the Viewer window, you can print the report and change the layout of the report.

Printing a Text File Report

There are two special reports that you can print: the **Video Director's Output** and the **Cumulative Stats**. These reports are text files, and are used by the clubs to assist their coaches with game analysis. A club's public relations staff member will request this report to be produced at the end of a game, and should provide a floppy disk to store the report on.

To print these reports:

1. Select **Text File Reports ▶ Video Director's Output**... or **Cumulative Stats**... from the File menu. The dialog that appears depends upon which report you select. The example dialog shown below is for the Video Output Director's File.
2. Select the directory in which you want to place the file. In most cases, this will be A:\. You can either change the drive listed in the Look in drop down list, or type A:\ in the Path field. A floppy disk with approximately 100KB of available space needs to be inserted into the computer before pressing the OK button.

3. Click **OK**.

---

### Printing Lists

Several of the lists in GSIS can be printed.

To print a list:

1. Press `<Ctrl+L>` or select **Print Lists**... from the **File** menu. The following dialog appears.
2. Select the list that you want to print.
3. Click **OK**.

From the Game Play screen, you can print out the list of Events & Attributes, the Play List, or a play’s Play Statistics. From the Roster screen, you can print out the selected team’s roster.

---

**Changing Application Options**

You can change a number of options that affect how GSIS operates and looks at any time during the game.

**Changing GamePlay Options**

The GamePlay options tab sets a number of options relating to the look of the Play List, how data is entered, and the look of the Playboard.

To specify display options:

1. Select **Options...** from the **Tools** menu. The Application Options dialog appears.

2. Set the options you want. To change one of the Play List color options, click on the colored square to the right of the option.
The selected options are stored in the computer’s Registry. GSIS will load the selected options each time it’s started, so you only have to set them once.

Changing Report Options

The Report application option tab customizes how some of the reports are printed and look.

To specify display options:

1. Select Options… from the Tools menu. The Application Options dialog appears.
2. Select the Reports tab. The Reports tab appears.

3. Check the Print on A4 Paper option if your printer uses A4 paper, instead of legal sized paper. This is only the case for NFL Europe teams, NFL teams should leave this option unchecked.
4. Check the Don’t change font size on play by play report check box if you want the report to print using the default font size. If you do not check this box and the quarter extends past the first page, in most cases GSIS will be able to reduce the point size to fit the entire quarter on one page. Unless specifically requested by the home club’s
public relations staff, you should leave this option unchecked.

5. Check the Include Play Start Time outside of Two-Minute Warning check box if you want the play’s start time included on every play from scrimmage, not just ones within the last two minutes of a half. Unless specifically requested by the home club’s public relations staff, you should leave this option checked.

6. Check the Include jersey numbers on play by play report check box if you want to include the players’ jersey numbers in the play by play report. Unless specifically requested by the home club’s public relations staff, you should leave this option unchecked.

7. Check the Include PR Notes check box if you want to include the comments made by the home team’s public relations staff on the GSIS PR Notes screen within the play by play text. Including these notes on the report does not replace any comments added by the data entry operator.

8. Press OK to Save your changes. Like the GamePlay option choices, the values chosen will persist between sessions of GSIS in the system registry.

Changing Sound Options

The values selected on the Sound options tab determine whether GSIS will play sounds after certain events, such as clapping after the home team scores, a chime if a play has been flagged, or a warning if the machine starts running on battery power. The Volume control panel applet must not be set to disable sounds through the computer speakers for these options to take effect.
Chapter 5

Post-game Activities

This chapter contains procedures for tasks that you must perform after the game has ended.

Updating Player Status

Introduction

You must update the roster with any status changes. For example, if a player did not play, you must change that player’s status to Did not play.

Updating the Status of a Player

To update the status of a player:

1. Use the <↑> and <↓> keys to highlight the player from the team roster.
   - The current information for that player is displayed in the Player Info tab.

   □ Press <Alt+I> if this tab is not currently being displayed.

2. Select the correct status from the Player Status drop-down list.

3. Press <Alt+S>, click Save, or press <Enter>. The status for that player is updated on the team roster.

Printing the Game Book

Introduction

After all statistics have been verified, you must print the game book for distribution.

Printing the Game Book

To print the game book

1. Press <Ctrl+P> or select Print Reports... from the File menu. The Print Reports dialog appears.
Chapter 5: Post-game Activities

Closing the Game

Introduction

After all statistics have been verified and the game book has been printed for distribution, you must close the game.

Closing the Game

You must be in the Game Play screen to close a game.

To close the game:

Select Close Game from the File menu.

When you close a game, GSIS checks to:

- Ensure that all players have valid jersey numbers.
- That no play has a start time before any preceding play.
- That at the end of every drive a play end time is recorded.
- Ensure there are no invalid down sequences (such as a 3rd down following a 1st down).
- Ensure that there are no open plays.

GSIS then notifies the Distribution Center (DC) that all data entry has been finalized. After receiving this information, the DC releases several key reports for distribution to NFL clubs and sports information services. When you close a game, this information is also made available to the NFL for post-game corrections.

You can re-open a game, if necessary, but only if either the NFL or the...
Elias Sports Bureau has not already opened the game for corrections.

The game can only be closed on the primary data entry machine. The PDE must be connected to the Distribution Center, either through the WAN or by a dial-up connection.
Appendix A

Running GSIS in Training Mode

This appendix describes how to use GSIS in training mode.

GSIS Training Mode

Introduction

You can use GSIS in training mode to practice play entry without sending data to the Distribution Center (DC). When you run GSIS in training mode, the laptop is not connected to the DC; therefore, all data that you enter is stored on the laptop and will not affect any regular or post-season games.

The following procedure assumes that you are logging on as a data entry operator.

Running the Training Program without an ISDN Connection

To run GSIS in training mode:

1. Select Programs, GSIS, GSIS Training Mode from the Start menu.
   The GSIS training program starts and the following prompt appears:

   ![Figure A-1: Primary Data Entry Prompt]

2. Click Yes.
   The following prompt appears.
3. Click **Cancel**.

   The following prompt appears.

   ![Image of GSIS Status Prompt](image)

   *Figure A-2: GSIS Status Prompt*

4. Click **Cancel**.

   The training mode game selection dialog appears.

   ![Image of Network Error Prompt](image)

   *Figure A-3: Network Error Prompt*

5. If there is an existing training game in the database and you want to use that game, click on the **Use this game** button.

6. If there is no existing training game, or you want to create a new training game with a different set of teams, choose the Away and Home teams using the drop downs and click on the **Create new game** button. Any existing training game will be deleted.

   Training games from previous seasons cannot be accessed. If there
Appendix A: Running GSIS in Training Mode

GSIS Training Mode

was a training game from a prior season in the database GSIS will require that a new game be created.
Appendix B

Viewing Historical Games

This appendix describes how to view historical games.

View Historical Games

Introduction
You use the View Historical Games program to see data that was entered during past games.

Viewing Historical Games
To view past games:

1. Select Programs, GSIS, View Historical Games from the Start menu.
   GSIS starts and the Select a Game dialog appears.
2. Select a game date from the Game Date drop-down list. The game available for that date appears.
3. Click OK to load the game.
   You can now view the game play information for that game.

You cannot edit any of the data in historical games.
Index

A
Acquiring a player, 36
Adding a new player to the roster, 38
Player Search dialog, 39
Adding statistics to a play, 70, 73
Advanced play search feature, 60, 63
Assigning a player default, 33, 45, 33, 45
Attribute values
entering, 52
Audit, 3

B
Basic play entry
sample play, 54
End of Play event, 56, 58
Rush event, 55, 56
Tackle event, 56, 58
valid first plays, 53

C
Change of possession, 59, 62
Changing a player's status, 40
Changing display options, 85, 88
Changing report options, 86, 89
Choices window
printing the, 67, 70
selecting an entry from the, 67, 70
using the Find field in the, 67, 70
Closing the game, 90
Comments
entering play, 67, 70
Correcting a play, 62, 65
Correcting invalid rosters, 33
Crossing midfield, 59, 62

D
Data Entry field
Game Play screen, 26, 25
Day start time
setting the, 58, 60
Defensive Stats
description of, 31, 30
displaying the, 75, 78
Deleting a play, 63, 67
Deleting a player from the roster, 42
Deleting an event, 64, 67
Display options
changing, 85, 88
multi-user validation errors, 85, 88
Drive Chart
description of, 29, 28
displaying the, 73, 76
Index

E
Editing play statistics, 68, 71
Editing player defaults, 44
Editing the rosters, 32
End of Game event, 72, 75
End of Play event, 56, 58
End time
setting, for plays, 58, 62
Ending the current play, 59, 62
Ending the current play and creating a new play, 59, 62
Ending the game, 72, 75
Entering an attribute, 52
Entering an event, 52
Entering play comments, 67, 70
Entering plays, 48
Entering pre-game information, 50
Events
deleting, 64, 67
entering, 52
inserting an event before the selected event, 64, 67
moving, 65, 68
Events and Attributes Model, 5
caption of next events, 6
description of, 5
Events and Attributes window
Game Play screen, 23, 22

F
Finding plays, 60, 63
advanced search options, 62, 65
Flagged plays
moving between flagged and open plays, 63, 66
Flagging a play, 63, 66
Flip card, 4
Function keys
for play entry, 48

G
Game Book
printing the, 89
reports included in the, 7
Game event, 50
Game play, 2
description of play entry, 5
Events and Attributes Model, 5
Game Play screen
Data Entry field, 26, 25
description of, 22, 21
Events and Attributes window, 23, 22
play board, 24, 23
Play List/Description window, 26, 25
play stats, 25, 24
refreshing the, 72, 75
score window, 26, 25
team stats, 26, 25
Game statistics
displaying the, 73, 76
GSIS In Game screens
Defensive Stats, 31, 75, 30, 78
Drive Chart, 29, 73, 28, 76
Game Play, 22, 21
Offensive Stats, 30, 74, 29, 77
Team Stats, 32, 76, 31, 79
GSIS interface
In Game, 2
Set Up, 2
GSIS Set Up screens
Player Defaults, 19, 18
Rosters/Starters, 13, 12
Startup, 20, 19
TV Stats, 19, 18
GSIS training mode
description of, 2

I
Inactive players, 36
Inserting a play before the selected play, 59, 62
Inserting an event before the selected event, 64, 67
Invalid roster, 16, 15
correcting, 33

K
Keyboard shortcuts
auto complete for play entry, 49
for exiting a dialog, 10
for navigating fields, 10
for navigating GSIS screens, 11
for play entry, 49
for player entry, 49
for radio buttons, 10
for Windows elements, 10
in check boxes, 10
in combo boxes, 10
in list views, 10
in menus, 10
yard line entry for play entry, 49

L
Lists
printing, 84, 87

M
Menu bar
Startup screen, 20, 19
Midfield
crossing, 59, 62
Moving an event, 65, 68
Moving between open plays and flagged plays, 63, 66
Navigation bar
Startup screen, 20, 19
New players
adding, to the roster, 38
Player Search dialog, 39
Next events, 6

O
Offensive Stats
description of, 30, 29
displaying the, 74, 77
Open plays
moving between open and flagged plays, 63, 66

P
Play board
Game Play screen, 24, 23
Play by Play report, 80, 83
setting additional options for the, 80, 83
Play Description tab
Play List/Description window, 29, 72, 28, 75
Play end time
setting the, 58, 62
Play entry
description of, 5
example of, 53
function keys for, 48
keyboard shortcuts for, 49
Play List tab
Play List/Description window, 26, 71, 25, 74
Play List/Description window
Game Play screen, 26, 25
Play Description tab, 29, 28
Play List tab, 26, 25
Play statistics
editing the, 68, 71
updating the, 69, 72
Play stats
Game Play screen, 25, 24
Play-by-play report
changing the font size, 86, 89
include players’ jersey numbers in, 86, 89
Player defaults
assigning, 33, 45, 33, 45
description of, 4
editing, 44
Player Defaults screen
assigning a player default, 33, 45, 33, 45
description of, 19, 18
Player Info tab
Rosters/Starters screen, 16, 15
Player information
updating, 33
Player Search dialog, 39
Index

Player Starters tab
Rosters/Starters screen, 18, 17
Player status
changing, 40
updating, 88
Players
acquiring, 36
adding new, to the roster, 38
Player Search dialog, 39
assigning default positions to, 33, 45, 33, 45
changing the status of, 40
deleting, from the roster, 42
duplicate uniform numbers, 33
editing defaults, 44
inactive, 36
updating the status of, 88
Plays
adding statistics to, 70, 73
advanced search feature, 60, 63
correcting, 62, 65
deleting, 63, 67
ending, 59, 62
ending the current play and creating a new play, 59, 62
finding, 60, 63
flagging, 63, 66
inserting a play before the selected play, 59, 62
moving between open and flagged plays, 63, 66
removing all override statistics from, 70, 73
removing statistics from, 70, 73
searching for, 60, 63
Possession
change of, 59, 62
Post-game activities, 7
close game, 7
game book, 7
roster updates, 7
PR Home, 3
PR Visitor, 3
Pre-game information
entering, 50
Pre-game setup, 2
player default updates, 4
player starter updates, 4
roster updates, 4
Previewing a report, 82, 85
Primary Data Entry, 3
Printing
Game Book, 89
lists, 84, 87
play-by-play report
for selected quarters, 80, 83
report, 78, 81
report to a file, 79, 82
Index

text file report, 83, 86

R
Real-Time Statistics Exporter
description of, 2
Refreshing the Game Play screen, 72, 75
Removing all override statistics from plays, 70, 73
Removing statistics from plays, 70, 73
Report options
changing, 86, 89
changing the play-by-play report font size, 86, 89
Reports
previewing, 82, 85
printing, 78, 81
printing text file, 83, 86
printing the play-by-play, for selected quarters, 80, 83
printing, to a file, 79, 82
sample, 82, 85
Roster list
Rosters/Starters screen, 14, 13
Rosters
editing the, 32
Rosters/Starters screen
acquiring a player, 36
adding a new player, 38
Player Search dialog, 39
changing a player's status, 40
deleting a player from the roster, 42
description of, 13, 12
Player Info tab, 16, 15
Player Starters tab, 18, 17
roster list, 14, 13
updating player information, 33
Rush event, 55, 56

S
Sample report, 82, 85
Score window
Game Play screen, 26, 25
Searching for plays, 60, 63
advanced search options, 62, 65
Section title
Startup screen, 20, 19
Setting the day start time, 58, 60
Setting the play end time, 58, 62
Start time
setting, for the day, 58, 60
Starting lineups
defensive, 18, 17
offensive, 18, 17
Starting the game, 50
Startup screen
description of, 20, 19
Menu bar, 20, 19
Index

Navigation bar, 20, 19
section title, 20, 19
status bar, 21, 20
system status message, 21, 20
Statistics
displaying, 73, 76
Status bar
Startup screen, 21, 20
System status message
Startup screen, 21, 20

T
Tackle event, 56, 58
Team stats
Game Play screen, 26, 25
Team Stats
description of, 32, 31
displaying the, 76, 79
TV Stats, 2
TV Stats screen
description of, 19, 18

U
Updated stats indicator, 69, 72
Updating player information, 33
Updating players' status, 88
Updating the play statistics, 69, 72
User roles
Audit, 3
PR Home, 3
PR Visitor, 3
Primary Data Entry, 3

V
Valid roster, 16, 33, 15, 33
View Historical Games, 2